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1.	 Description

The Plexor® HY System(a–f) is a novel real-time PCR system for the quantification of total human (autosomal) and 
human male (Y) DNA within a sample. This Technical Manual describes the Plexor® HY System and provides  
instructions for use with the Stratagene Mx3000P® and Mx3005P™ Quantitative PCR Systems, including reaction 
setup, real-time PCR instrument programming and data analysis using the Plexor® Analysis Software.

The Plexor® Technology takes advantage of the specific interaction between two modified nucleotides to achieve 
quantitative PCR analysis (1–3). One of the PCR primers contains a modified nucleotide (iso-dC) linked to a fluores-
cent label at the 5´ end. The second PCR primer is unlabeled. The reaction mix includes deoxynucleotides and 
iso-dGTP modified with the quencher dabcyl. Dabcyl-iso-dGTP is incorporated opposite the iso-dC residue in the 
primer. The incorporation of the dabcyl-iso-dGTP at this position results in quenching of the fluorescent dye on the 
complementary strand and a reduction in fluorescence, which allows quantification during amplification (Figure 1).
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Figure 1. Schematic diagram illustrating the Plexor® real-time PCR process.
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With the Plexor® technology, accumulation of product is accompanied by a decrease in fluorescence as shown in  
Figure 2.

The Plexor® Technology allows the use of a melt curve or dissociation curve to determine the melting temperature (Tm) 
of the products following amplification (Figure 3). This is useful in assessing the specificity of the reaction.
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Figure 2. Representative Plexor® amplification curves. The amplification curves show the fluorescence (in 
relative fluorescence units, RFU) at each cycle of the reaction. The amplification threshold is indicated by a horizontal 
line across the graph. This line is used to determine the cycle threshold (Cq) for the samples.
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Figure 3. Representative Plexor® melt curves. Melting temperature is empirically determined by plotting the 
change in fluorescence with temperature (–dRFU)/dT versus temperature and determining the temperature at which 
the greatest rate of change in fluorescence occurs.
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1.	 Description (continued)

The fluorescein (FAM™) dye of the Plexor® HY System is used to detect a human autosomal DNA target. The primers 
amplify a multicopy 99bp target on chromosome 17. Data from this reaction are used to quantify the total amount of 
human DNA in a sample.

The CAL Fluor® Orange 560 dye of the Plexor® HY System is used to detect a Y-chromosomal DNA target. The primers 
amplify a multicopy 133bp target on the Y chromosome. Data from this reaction are used to quantify the total amount 
of human male DNA in a sample.

The CAL Fluor® Red 610 dye of the Plexor® HY System is used to detect the Internal PCR Control (IPC), which is 
added to every reaction. The primers amplify a novel DNA sequence added as a template to the reaction mix. The 
amplified product is 150 base pairs. Data from this target are used to monitor inhibition of amplification in samples.

The IC5 dye of the Plexor® HY System is used as a passive reference. IC5-labeled reagent is included in the Plexor® HY 
20X Primer/IPC Mix. Data from the three amplification channels (fluorescein, CAL Fluor® Orange 560 and CAL Fluor® 

Red 610) can be normalized to this signal.

The Plexor® HY System uses a hot-start chemistry. Reaction setup can be performed at room temperature and is 
amenable to automation.

2.	 Product Components and Storage Conditions

P R O D U C T 	 S I Z E 	 C AT. #

Plexor® HY System	 200 reactions	 DC1001

Not for Medical Diagnostic Use. Includes:

•	 2 × 1ml	 Plexor® HY 2X Master Mix
•	 200µl	 Plexor® HY 20X Primer/IPC Mix
•	 150µl	 Plexor® HY Male Genomic DNA Standard, 50ng/µl
•	 2 × 1.25ml	 Water, Amplification Grade

P R O D U C T 	 S I Z E 	 C AT. #

Plexor® HY System	 800 reactions	 DC1000

Not for Medical Diagnostic Use. Includes:

•	 8 × 1ml	 Plexor® HY 2X Master Mix
•	 4× 200µl	 Plexor® HY 20X Primer/IPC Mix
•	 3 × 150µl	 Plexor® HY Male Genomic DNA Standard, 50ng/µl
•	 5 × 1.25ml	 Water, Amplification Grade

Storage Conditions: Store the Plexor® HY System at –30°C to–10°C in a nonfrost-free freezer. Once thawed, store  
the Plexor® HY Male Genomic DNA Standard at 2–10°C; do not refreeze. For short-term storage, less than 1 week,  
the other components of the system can be stored at 2–10°C. Minimize the number of freeze-thaw cycles.
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3.	 General Considerations

The key to the Plexor® technology is the quenching of a fluorescent reporter due to the site-specific incorporation of 
dabcyl-iso-dGTP. As a result, the fluorescent signal from a Plexor® HY reaction decreases as PCR product accumulates. 
Real-time instrument software can record the quenching data, but most cannot determine cycle thresholds or melting 
temperatures. Data analysis is accomplished by exporting the data to the Plexor® Analysis Software. The Plexor® 
Analysis Software is compatible with data from all supported instruments. The software is compatible with Windows® 
98 and later operating systems.

Before using the Plexor® HY System, be sure you have the forensic release of the Plexor® Analysis Software. All 
instructions in this Technical Manual refer to the forensic release of the software. The Plexor® Analysis Software and 
instructions for software installation can be downloaded free of charge from the Promega Web site at:  
www.promega.com/plexorhy/

We recommend using designated work areas and pipettes for pre- and postamplification steps to minimize the potential 
for cross-contamination between samples and prevent carryover of nucleic acid from one run to the next. Wear gloves, 
and change them often. Prevent contamination by using aerosol-resistant pipette tips. Always include a no-template 
control (NTC) reaction to detect contamination. We recommend performing NTC reactions in duplicate.

! 	 Do not unseal reaction plates after amplification is complete. Unsealing the plates increases the risk of  
contaminating subsequent reactions with amplified product.

	 Caution: We highly recommend the use of gloves and aerosol-resistant pipette tips.

4.	 Reaction Plate Setup

When using the Plexor® HY System for the first time, we recommend programming the instrument (Section 5) before 
assembling the reactions. Once you are familiar with the programming process, the instrument can be programmed 
after reaction setup.

Materials to Be Supplied By the User
(Solution compositions are provided in Section 10.K.)

•	 sterile, aerosol-resistant pipette tips

•	 pipettes dedicated to pre-amplification work

•	 real-time PCR instrument and related consumables, such as the appropriate PCR plate and caps or plate covers

•	 TE–4 buffer

•	 Plexor® Analysis Software (forensic release)

!
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4.A.	 Template Preparation

Change gloves often, especially after handling high-concentration DNA. These instructions use 2µl of template DNA 
per reaction. The sample volume can be increased as long as the final reaction volume stays constant. Sample volumes 
and final reaction volumes must be the same for both the DNA standards and the unknown samples, allowing the DNA 
standards to be considered as a concentration (in ng/µl) instead of input amount in ng (ng/µl × volume). The standard 
curve described below uses DNA standards in the range of 3.2pg/µl to 50ng/µl. These values can be modified if 
desired. See Section 10.B.

Sample DNA Templates (Unknowns)

Use 2µl of sample DNA per reaction. Performing duplicate analysis of each sample DNA and averaging the  
quantification results can reduce variability. The sample DNA can be diluted in TE–4 buffer, if desired.

DNA Standards

The Plexor® HY System is supplied with the Plexor® HY Male Genomic DNA Standard, 50ng/µl. This DNA is a mixture 
of human male DNA. Use of other DNA (e.g., DNA isolated from a cell line) as a standard is not recommended.

Serial dilutions of the DNA standard are amplified in the same plate as the unknown samples, and the results are used 
to generate a standard curve in the autosomal (fluorescein) and Y (CAL Fluor® Orange 560) dye channels to determine 
the concentrations of unknown samples. We recommend performing duplicate or triplicate amplification reactions with 
each dilution of the DNA standard. Use of a dedicated set of pipettes can increase run-to-run consistency. Use the same 
pipettes to dispense the DNA standards and unknown samples.

	 Multiple freeze-thaw cycles of the Plexor® HY Male Genomic DNA Standard, 50ng/µl, can increase variability in 
the standard curve. High-molecular-weight DNA may form aggregates or concentration gradients when frozen, 
which may result in sampling error. Store the DNA standard at 4°C overnight before using it for the first time 
and vortex prior to use. We recommend long-term storage at 2–10°C.

1.	 Thaw and vortex the Plexor® HY Male Genomic DNA Standard, 50ng/µl, at high speed for 10 seconds. After 
initial thawing, store at 2–10°C.

2.	 Prepare fresh serial dilutions of the Plexor® HY Genomic DNA Standard as indicated in Table 1. Vortex each 
dilution for 10 seconds before removing an aliquot for the next dilution. Be sure to change pipette tips between 
dilutions. Change gloves after handling high-concentration DNA.

!
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Table 1. Serial Dilution of the Plexor® HY Genomic DNA Standard.

Concentration Volume of DNA Volume of TE–4 Buffer

50ng/µl Use undiluted DNA 0µl

10ng/µl 10µl of undiluted DNA 40µl

2ng/µl 10µl of 10ng/µl dilution 40µl

0.4ng/µl 10µl of 2ng/µl dilution 40µl

0.08ng/µl 10µl of 0.4ng/µl dilution 40µl

0.016ng/µl 10µl of 0.08ng/µl dilution 40µl

0.0032ng/µl 10µl of 0.016ng/µl dilution 40µl

Note: We do not recommend storing diluted standards.

No-Template Control

Include a no-template control (NTC) reaction for each set of reactions. Add 2µl of TE–4 buffer to these reactions in 
place of the template DNA. There should be no amplification product (i.e., <1.0pg/µl with a 2µl input volume) detected 
in the NTC reaction. Amplification of >1.0pg/µl of DNA in the NTC reaction indicates nonspecific amplification or the 
presence of contaminating DNA.

Note: The Plexor® HY System is extremely sensitive. The NTC reaction may show amplification products in the 
subpicogram range.

4.B.	 Reaction Setup

1.	 Thaw the Plexor® HY 2X Master Mix, Plexor® HY 20X Primer/IPC Mix and Water, Amplification Grade.

	 Note: Do not thaw the Plexor® HY 2X Master Mix and Plexor® HY 20X Primer/IPC Mix at temperatures above 
room temperature.

2.	 Briefly vortex the Plexor® HY 2X Master Mix and Plexor® HY 20X Primer/IPC Mix for 10 seconds to mix.  
Do not centrifuge after vortexing, as this may cause the primers to be concentrated at the bottom of the tube.

3.	 Determine the number of reactions to be set up. This should include negative control reactions. Increase this 
number by 10–15% to compensate for pipetting error. While this approach does require using small amount 
of extra reagent, it ensures that you will have enough PCR master mix for all samples. It is critical that the same 
reaction mix is used for the entire run.
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4.B.	 Reaction Setup (continued)

4.	 Prepare the reaction mix by combining the Water, Amplification Grade, Plexor® HY 2X Master Mix and Plexor® 
HY 20X Primer/IPC Mix as indicated in Table 2. The reaction mix will be used to perform the NTC reaction and 
amplify samples and DNA standards. To amplify a larger input template volume, see Section 10.B.

Table 2. Preparation of Reaction Mix for Quantification Assays (assumes 2µl of template per reaction).

Component Volume (Per Reaction)

Plexor® HY 2X Master Mix 10µl

Water, Amplification Grade 7µl

Plexor® HY 20X Primer/IPC Mix 1µl

final volume 18µl

5.	 Vortex for 10 seconds to mix. Do not centrifuge after vortexing.

6.	 Add 18µl of the reaction mix prepared in Step 4 to each of the appropriate wells of an optical-grade PCR plate.

7.	 Add 2µl of TE–4 buffer to the NTC reactions (Figure 4).
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Figure 4. Schematic diagram showing distribution of the diluted DNA standard and unknown samples 
(UNK) in a 96-well PCR plate.

8.	 Add 2µl of DNA standard or unknown sample to the reaction mix in the appropriate wells (Figure 4). Duplicate 
amplification of standards is required. Duplicate analysis of unknown samples and subsequent averaging of the 
DNA concentration will reduce the impact of variability due to pipetting, sampling or amplification.

9.	 Seal the plates with manufacturer-approved optical caps or optical adhesive cover using the applicator.

10.	 Centrifuge the plate briefly to collect the contents of the wells at the bottom. The plate is ready for thermal  
cycling. Protect the plate from extended light exposure or elevated temperatures before cycling. Handle the plate 
by the edges, and avoid touching the bottom of the plate.
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5.	 Instrument Setup and Thermal Cycling

5.A.	 Dye Setup For First Use

At the first use of the Plexor® HY System with the Stratagene Mx3000P® or Mx3005P™ Quantitative PCR System, you 
must configure the instrument for the fluorescein, CAL Fluor® Orange 560, CAL Fluor® Red 610 and IC5 dyes. For 
subsequent runs, proceed directly to Section 5.B for general setup instructions.

1.	 Open the Mx3000P® or Mx3005P™ software.

2.	 Select “SYBR Green (with Dissociation Curve)” from the New Experiment Options window (Figure 5). Select “OK”.

3.	 Select the Optics Configuration icon: 

4.	 In the Optics Configuration window that appears, select the Dyes & Filters tab (Figure 6).

5.	 In the Dye definitions box, type “CO560” for “Name”, and select “HEX-JOE Filter Set” for “Filter set”.
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Figure 5. The New Experiment Options window.
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Figure 6. Dyes & Filters tab of the Optic Configuration window.
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5.A.	 Dye Setup For First Use (continued)

6.	 Select “Add”.

7.	 Select a dye color in the window that appears. Select “OK”.

8.	 Repeat Steps 3–5 for CR610, designating the “ROX Filter Set”. Repeat Steps 3–5 for IC5, designating the  
“CY5 Filter Set”. The “FAM Dye definition” is used to collect fluorescein data.

9.	 Select the Dye Assignment tab (Figure 7).
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Figure 7. The Dye Assignment tab of the Optics Configuration window.

10.	 From the available drop-down boxes, choose “IC5” for the CY5 Filter Set, “CR610” for the ROX Filter Set, 
“CO560” for the HEX-JOE Filter Set and “FAM” for the FAM Filter Set.

11.	 Select “OK”.

	 Note: No dye calibration is required.

12.	 In the Instrument menu, select “Filter Set Gain Settings...” (Figure 8).

67
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Figure 8. Filter Set Gain Settings window.

13.	 In the Filter Set Gain Settings window that appears, set the “Filter set gain multiplier” as follows: CY5, x1;  
CY3, x1; ROX, x1; HEX-JOE, x1; and FAM™, x2.

	 Notes:

1.	 Values will be used in subsequent runs unless changed. These settings can be saved as “lab defaults”.

2.	 Values may need to be adjusted based on the results of the first Plexor® HY run. See Section 8.A.

3.	 The CY3 multiplier is not applied to the dyes used in this system.
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14.	 Select “OK”.

15.	 Proceed to Section 5.B, Step 3, when you are ready to begin the thermal cycling program.

5.B.	 General Setup

1.	 Open the Mx3000P® or Mx3005P™ software.

2.	 Select “SYBR Green (with Dissociation Curve)” from the New Experiment Options window (Figure 5). Select “OK”.

3.	 If the lamp is not currently on, preheat the lamp by clicking on the following icon: 

	 Note: The software will request 20 minutes of warmup time before thermal cycling can begin.

4.	 Select the Plate Setup tab (Figure 9).

	 Note: When setting up the instrument for the first time, you must configure the instrument for the CAL Fluor® 
560, Cal Fluor® 610 and IC5 dyes (see Section 5.A).

5.	 Highlight the wells to be used.

! 	 Do not highlight wells that are not being used (i.e., wells that do not contain reaction mix). Including unused 
wells will significantly impact the scale of the X and Y axes when viewing the data.

6.	 Select “Unknown” as the Well Type.

	 Note: Do not assign a sample type or quantity during instrument setup because this information is not exported. 
Sample names, type and quantities (for standards) can be entered in the Plexor® Analysis Software.
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Figure 9. The Plate Setup tab.
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5.B.	 General Setup (continued)

7.	 Check the FAM, CO560 and CR610 boxes (Figure 9) under “Collect fluorescence data”.

8.	 Select “IC5” as the reference dye.

5.C.	 Thermal Cycling Program

The thermal cycling program is shown in Table 3. Figure 10 illustrates the final thermal cycling program.

Table 3. Thermal Cycling Program.

Step Temperature Time Number of Cycles

Initial denaturation: 95°C 2 minutes 1 cycle

Denaturation: 95°C 5 seconds
38 cycles

Annealing and extension: 60°C 40 seconds

Melt temperature curve:
65°C initial temperature with 0.6°C increase each 

cycle, 40-second hold each cycle
48 cycles

67
96

TA

Figure 10. The final thermal cycling program for the Plexor® HY System.
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1.	 Select the Thermal Profile Setup tab (Figure 10).

2.	 Change the plateau in Segment 1 to 95°C for 2:00.

3.	 Segment 2 is a cycling program. Change the cycle number for Segment 2 to 38.

4.	 Change the first plateau of Segment 2 to 95°C for 00:05.

5.	 Change the second plateau of Segment 2 to 60°C for 00:40.

6.	 Data collection for Segment 2 should occur during the 60°C plateau. Edit the number of collection points by 
highlighting the 60°C plateau and selecting “Edit Properties”.

7.	 In the dialog box, change “# of endpoints” to “2” (Figure 11). Select “OK”.
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Figure 11. The Plateau Properties window for the amplification elongation/extension.

8.	 Delete the third plateau (elongation) by highlighting the plateau and selecting the Delete button.

9.	 Segment 3 is a dissociation (melt) program. Delete the first and third plateau in Segment 3.

10.	 Segment 3 now includes one plateau. Highlight the plateau, and select “Edit Properties”.
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5.C.	 Thermal Cycling Program (continued)

11.	 In the Plateau Properties window, change the following parameters (Figure 12):

	 “Duration” to “00:40”

	 “Temperature” under “First Cycle” to “65” degrees

	 “Temperature” under “Cycle Increments” to “0.6” degrees/cycle

	 “Type” to “Endpoint”

	 “# of endpoints” to “2”

67
95

TA

Figure 12. The Plateau Properties window for the melt program.

12.	 Change the cycle number for Segment 3 to 48.

13.	 Choose “File” and then “Save As” to save the file.

	 Note: The saved file can be used as a Plate Setup or Thermal Profile Setup template for future use. To use an  
existing plate setup or thermal profile setup, select “Import”, and select a previous run with the desired Plate 
Setup or Thermal Profile Setup.

14.	 Place the PCR plate into the instrument, and immediately begin thermal cycling.

! 	 Prolonged exposure of the reactions to high temperatures or light before thermal cycling may adversely affect the 
final results.
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6.	 Data Export from the Stratagene Mx3000P® and Mx3005P™ Quantitative PCR Systems

Before data can be analyzed using the Plexor® Analysis Software, the data must be exported from the Mx3000P® or 
Mx3005P™ software. One file is exported with both the amplification and melt/dissociation data. Be sure to use a 
descriptive file name.

1.	 To export the data, open the instrument software, and select “File”, “Export Instrument Data”, then “Export 
Instrument Data to Text File” and “Format 3—Grouped by Wells (assay columns)” (Figure 13).

2.	 Save this .txt file with an appropriate name.

	 Note: If the data will be analyzed on a separate computer, save the files on removable storage media or acces-
sible network location for data transfer. These files are now ready for use with the Plexor® Analysis Software.
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Figure 13. Exporting instrument data.
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7.	 Data Import into the Plexor® Analysis Software

Before using the Plexor® HY System, be sure you have the forensic release of the Plexor® Analysis Software. The 
Plexor® Analysis Software and instructions for software installation can be downloaded free of charge from the 
Promega Web site at: www.promega.com/plexorhy/

1.	 To launch the Plexor® Analysis Software, go to the Start menu, select “Programs” and then “Plexor”. Select 
“Analysis Desktop”.

	 Notes:

1.	 A shortcut can be placed on the desktop by right-clicking on the Analysis Desktop, selecting “Copy” and 
then right-clicking on the Windows® desktop and selecting “Paste Shortcut”.

2.	 A master template for routine settings for import and analysis can be created. See Section 10.G for details 
concerning this option.

2.	 In the File menu, select “Set Passive Reference On Import”. With the Mx3000P® or Mx3005P™ software, the 
IC5 passive reference data is imported separately, and normalization is applied within the Plexor® Analysis  
Software.

3.	 In the File menu, select “Import New Run” or select the icon: 

4.	 Optional: Enter an assay name in the Assay Setup screen, Step 1 (Figure 14). This screen is used to enter  
information about the type and format of data that will be used for each assay.
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Figure 14. The Assay Setup screen.
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5.	 Select “Stratagene Mx3000P” or “Stratagene Mx3005P” as the instrument type.

6.	 Select “Add Target” four times.

7.	 For each dye, assign a target name, enter the correct dye name (FAM for Autosomal, CO560 for Y, CR610 for 
IPC and IC5 for the passive reference), and indicate there is amplification data and dissociation (melt) data to be 
analyzed for the FAM™, CO560 and CR610 dyes.

	 Notes:

1.	 The name of the dye must be the same as that in the data file (Section 5.B).

2.	 You can select “Export” and save the assay setup as an Assay Template file (.atp) for subsequent analysis. 
See Section 10.G for more details.

8.	 Indicate the IC5 data is reference data by checking the Pass. Ref. box; the Amplification and Melt boxes will 
automatically become deselected.

9.	 Select “Next”.

10.	 Optional: Enter information specific to your run in the Run Info screen, Step 2 (Figure 15). Details such as the 
date, notes, title, etc., also can be entered in the provided windows.
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Figure 15. The Run Info screen.

11.	 Select “Next”.
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7.	 Data Import into the Plexor® Analysis Software (continued)

12.	 Use the File Import screen, Step 3 (Figure 16), to specify the data file exported from the instrument in Section 6. 
Use “Browse” to locate the appropriate exported data file.

	 Note: “Advanced Options” can be used to create templates for routine plate setups and analysis conditions. See 
Section 10.G for details concerning these advanced options and an explanation of the default analysis settings.
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Figure 16. The File Import screen. Specify the data file to be imported and run parameters. Templates also may be 
applied.

13.	 Select “Finish” to complete the data import and open “Analysis Desktop”.

	 Note: If the names of the dyes you have entered do not match those listed in the data files, an error message will 
appear (Figure 17). If this message appears, return to the Assay Setup screen, Step 1 (Figure 14). Click on the 
Dye field under the Data Collection heading, and enter the dye names exactly as shown in the error message after 
“Found:”. Any dye name entered must exist in the data file. Only those dyes entered will be analyzed. Repeat 
Steps 7–13 of this protocol.
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Figure 17. The Dye Mismatch error message.
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8.	 Data Analysis with the Plexor® Analysis Software

After data import is complete (Section 7), the PCR Curves tab of the Analysis Desktop is displayed (Figure 18).

Note: The columns presented within any report or table, such as the graph legends shown in Figures 18 and 22, can be 
customized to suit your preferences:

•	 Columns can be reordered by placing the cursor over the column header, click-hold on column header and drag 
to the desired location.

•	 To add or delete columns, right-click within the table, select “Change Columns Shown” and a list of all possible 
columns for display will appear. Check or uncheck the boxes as appropriate.

•	 Data can be sorted by any criterion by clicking on the column header. A subsequent click of the column header 
will reverse the sort order. Data can be sorted by a second criterion by holding the Shift key and clicking on 
another column header. Shift-clicking on the column header subsequent times will change the secondary sort 
order from ascending to descending, then will remove the secondary sort.

•	 The “Well” column displays the physical location of samples in the plate. The default sort order is by column; to 
sort by row, right-click within the table and toggle-on the option “Sort by Row”.

•	 Concentration values (“Conc” column) are presented in scientific notation by default. To present the data in 
standard notation, right-click within the table and toggle-off the option “Scientific Notation”.

•	 To save modifications to the table or report display, right-click within the table and toggle the option “Save table 
defaults”.
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Figure 18. The PCR Curves tab of the Analysis Desktop. The amplification curves window, melt curves window 
and well selector are indicated.
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8.A.	 Confirming that Signal Intensities are Within the Instrument’s Linear Range

When performing Plexor® HY analyses for the first time with an Mx3000P® or Mx3005P™ quantitative PCR system,  
it is important to review the initial raw signal intensities to confirm that the values are within the linear range of the 
instrument.

1.	 Select all wells by clicking on the top left box in the well selector.

2. 	 Select “Show Raw Data” in the Tools menu.

3.	 The signal intensities after approximately 10 cycles should be within the range of 10,000–35,000RFU for all four 
dyes.

4.	 If values are not between 10,000RFU and 35,000RFU, proceed to Section 5.A, Steps 13 and 14, to adjust the 
gain settings. Repeat the amplification reactions with the adjusted gain settings.

	 When the values are in the range of 10,000–35,000RFU, proceed to Section 8.B.

8.B.	 Sample Definition

Sample definition, color selection and DNA concentration of standards will be entered for all dyes.

Use the well selector, which is shown in Figure 18, to select and define each well or group of wells. Choose one of the 
icons shown in Figure 19 to define the samples.

Colors can be assigned to samples to provide distinction to the displayed data. Select the samples, and then select 
“Color Assignment” to apply a color to the selected sample(s). Assigning or changing a color does not alter the 
information associated with a sample. For example, the DNA concentrations of standards will be retained if the display 
color associated with those samples is changed.

A sample or set of samples can be permanently deleted from a Plexor® HY analysis. Go to the PCR Curves tab, and 
select the samples. Use the delete key, or select “Remove Selected Wells” in the Edit menu.

! 	 These instructions are for DNA standard setup as described in Section 4.A, using concentrations in ng/µl. The 
volume of template used for the DNA standard reactions must be the same as that for unknowns.

1.	 Define the DNA standards.

a.	 Use the well selector to highlight wells that contain DNA standards.

b.	 Select the Create Dilution Series icon: 
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c.	 Confirm that the series selected is “Vertical Series” and the series is “Decreasing”. Enter 50 for the starting 
concentration and 5 for the dilution factor. See Figure 20.

Notes:

1.	 Results with the 0.0032ng/µl dilution of the DNA standard may exhibit increased variability compared 
to those of other standard dilutions. Definition of the 0.0032ng/µl dilution as a standard is optional. See 
Section 8.D. The 0.0032ng/µl dilution should be included on each plate. Amplification of the 0.0032ng/µl 
samples will confirm the sensitivity of the assay in each run.

2.	 The software does not accept commas or unit definitions in the concentration assignments.
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3.	 The unit definition for DNA quantity can be changed throughout the data analysis to describe concentra-
tions in pg/µl rather than ng/µl. To report concentrations in pg/µl, change the input values as follows:

	 In Step 1.c above, confirm that the series selected is “Vertical Series” and the series is “Decreasing”. Enter 
50,000 for the starting concentration and 5 for the dilution factor.

	 In Section 8.E, Steps 6–8, select the check boxes for picograms and enter values as pg/reaction and pg/µl.

	 Results in the report sections will now be in pg/µl.

Unknown

No-template control

Standard sample. The concentration is entered in a pop-up window following  
designation of a well as a standard.

Selecting the wells and choosing the Create Dilution Series icon can automatically 
create a titration curve across several wells.

Positive control

Color assignment

Figure 19. The icons used to define samples in the Plexor® Analysis Software.
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Figure 20. The Assign Dilution Series window.
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8.B.	 Sample Definition (continued)

2.	 Define the no-template control reactions.

a.	 Use the well selector to highlight the wells that contain NTC reactions.

b.	 Select the NTC icon: 

3.	 Assign sample names to the unknowns.

a.	 Select the Sample Names tab (Figure 21). Select the well, and enter the desired sample name. Repeat to 
enter sample names for other wells.

b.	 Enter the same sample name for duplicate samples. The calculated DNA quantities for samples with the 
same sample name will be averaged in the Forensics report (Section 8.E).

c.	 Names can be copied from a Microsoft Excel® spreadsheet, provided that the cells are arranged in the same 
array as your samples (e.g., 8 × 12). Highlight the sample names in the spreadsheet, and select “Copy”. In 
the Edit menu of the Plexor® Analysis Software, select “Paste Sample Names from Template” or use the 
control T shortcut. The layout of the sample names in the spreadsheet must be the same as the layout of the 
samples within the PCR plate.
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Figure 21. The Sample Names tab.

8.C.	 Adjusting the Expected Target Melt Temperature

Set the expected target melt temperature and the expected target melt temperature range. Failure to set the range for 
the expected target melt temperature correctly will cause the results to be incorrectly reported in the graph legend and 
reports (Sections 8.E and 8.I). The expected melt temperature range must be adjusted for all three dye channels 
(FAM™, CO560 and CR610 dyes).
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The average expected target melt temperature values are instrument-dependent. However, the average expected target 
melt temperature for the autosomal target (FAM™ dye) is generally in the range of 79–81°C, and the average expected 
target melt temperature for the Y-chromosomal target (CO560 dye) is generally in the range of 81–83°C. The average 
expected target melt temperature for the IPC (CR610 dye) is generally in the range of 79–81°C, but for some samples, 
the IPC Tm value can fall outside this range by as much as 2°C. Adjust the lower bounds of the expected melt range to 
encompass these samples, if desired. Amplification data, in particular the Cq value, are the primary means of analyzing 
IPC data.

1.	 Select the PCR Curves tab. The default setting for the expected target melt temperature is 90.0, and the default 
target Tm range is +/–1.5°C.

2.	 Select wells containing the DNA standards. The Tm for each selected sample will be displayed in a table to the 
right of the graph (Figure 22). The expected target melt temperature and associated target melt temperature 
range for all samples in this dye channel should be set based on the Tm of these standards.

3.	 In the Melt Curves window, move the mouse so that the arrow is over the expected target melt temperature line, 
and drag the line to the midpoint of the melt curves. Alternatively, double-click on the line, and enter the desired  
temperature. See Notes 1–6.
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Figure 22. The target melt temperature is displayed in a table to the right of the graph.
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8.C.	 Adjusting the Expected Target Melt Temperature (continued)

Notes:

1.	 The target melt temperature range can be adjusted manually. Move the mouse so that the arrow is over the upper 
or lower limit, and drag the limit to the desired temperature. Alternatively, upper and lower limits can be adjusted 
by double-clicking on the appropriate lines and entering an exact value in the pop-up window that appears.

2.	 The melt threshold is the level of signal that must be reached for the Plexor® Analysis Software to “call” the melt 
results. Target Tm indicators are included in the table to the right of the amplification and melt curve windows. 
See Section 10.E for advanced options to set the melt threshold.

3.	 A “Yes” or “No” in the Tm? column indicates whether a sample Tm is within the expected target melt temperature 
range. A “No Call” in this column indicates that the melt curve displays the expected target melt temperature, but 
there is insufficient amplification product to cause the melt curve to cross the melt threshold.

4.	 The “Tm#” is the number of peaks that cross the melt threshold line. More than one peak indicates heterogeneous 
amplification products. This may be due to nonspecific amplification.

5.	 An increase in Tm for the unknowns relative to that of the DNA standards may be the result of impurities remain-
ing after DNA extraction. To remove these impurities, increase the number of wash steps or comparable steps.

6.	 The default display of the melt curve has not been processed beyond the melt curve derivation. In some cases 
it may be helpful to view a smoothed melt curve using a Gaussian fit of the raw melt curve data to deemphasize 
minor variability in the melt data. To change the display, right-click on the Melt Curves window, choose “Select 
Melt Data”, then select “Gaussian Fit”. Note that any melt curve that does not meet the melt threshold will be 
rendered as a straight line (y intercept = 0) in this view.

8.D.	 Generating a Standard Curve and Determining Concentrations of Unknowns

Amplification results from the dilution series of the DNA standard are used to generate a standard curve. This standard 
curve is used to determine the DNA concentration of unknown samples. Samples for generating the standard curve 
must be designated as standards (Section 8.B). Standard curves must be generated for the autosomal (FAM™) and Y 
(CO560) channels.

The Plexor® Analysis Software performs a linear regression to the standard dilution series data and calculates the 
equation for the best-fit line (the standard curve). The equation is in the form of y = mx + b, where x = log concentration 
and y = Cq (if using the software default settings). The R2 value is a measure of the fit of the data points to the regressed 
line. The slope (m in the equation) is an indication of the PCR efficiency. A slope of –3.3 indicates 100% PCR efficiency 
(i.e., the number of copies of amplification product is doubled at each cycle). The y intercept (b in the equation) is 
defined as the y value (Cq) when x (log concentration) equals 0. Therefore, b gives the Cq for the 1ng/µl standard if 
concentrations are defined as described in Figure 20 (log10(1) = 0). If the value for b changes significantly from run to 
run without a change in the slope or R2 value of the standard curve, then this suggests the DNA standard was not 
sufficiently mixed before use or has degraded.

In general, the standard curve for the autosomal target (FL) has an average slope (m) in the range of –3.1 to –3.7 and 
an R2 value ≥0.990. The standard curve for the Y-chromosomal target (CO560) generally has an average slope (m) in 
the range of –3.0 to –3.6 and an R2 value ≥0.990.
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Low R2 values (R2≤0.98) may be due to variability in the amplification results for the replicate samples of the 
0.0032ng/µl dilution. The 0.0032ng/µl dilution may exhibit increased variability compared to the other dilutions of 
the DNA standard, most notably in the autosomal reactions. If a low R2 value is observed, change the sample type for 
the 0.0032ng/µl standards to “unknown”. The software will automatically incorporate this change into the standard 
curves. If this does not improve the R2 value, proceed to Section 9 and review the comments for “Variability in signal 
among replicate samples”, “Nonlinear standard curve, low R2 values ≤0.98” and “Slope is outside of the range specified 
in Section 8.D”.

1.	 In the autosomal channel (FAM tab), select all samples and DNA standards. Select “Add Standard Curve” to 
generate a standard curve and determine DNA concentrations of the unknowns based on the standard curve.

	Add Standard Curve

2.	 Repeat Step 1 for the Y channel (CO560 tab).

3.	 Select the Standard Curves tab to view the standard curves (Figure 23). One subtab shows the autosomal 
(FAM™) standard curve, and a second subtab displays the Y (CO560) standard curve. The default display shows 
the log concentration on the X axis and cycle threshold on the Y axis.

	 Note: All samples analyzed together will be displayed in the standard curve by default. To view only the plot of 
the standards, right-click in the Curve panel and the “Display Only Standards” option will appear. This option 
can be toggled on or off.

4.	 View DNA concentrations for all samples, including the unknown samples, in the table next to the standard curve 
graph (Figure 23). The calculated concentrations also can be viewed in the sample details report (Section 8.I).

	 Note: Samples that do not cross the amplification threshold, such as the no-template controls, are listed in the 
graph as not having a valid Cq value.
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Figure 23. The Standard Curves tab.
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8.E.	 Normalization of DNA Quantification Results for Input into STR Reactions and Setup of IPC  
Parameters

After generating standard curves and quantifying unknowns for autosomal and Y-chromosomal DNA, the  
quantification results can be used to prepare short tandem repeat (STR) amplifications. A normalization tool is 
incorporated into the Plexor® Analysis Software to help determine a) which samples are suitable for analysis, b) which 
samples require dilution, c) which samples may need repurification for accurate quantification, and d) how much 
sample should be added to your autosomal STR amplifications (e.g., PowerPlex® Fusion reactions) or Y-chromosomal 
STR amplifications (e.g., PowerPlex® Y23 reactions).

DNA concentrations determined by autosomal and Y-chromosomal quantification may differ. Quantitative PCR results 
and the copy number of the target sequences can vary. You may see small differences in the quantification results for the 
same sample. The preferred DNA amount for subsequent STR analysis should be defined through laboratory validation 
of the STR assays in conjunction with Plexor® HY quantification.

Note: Quantification results for samples with identical sample names will be averaged by the normalization tool.

Following normalization, a new Forensics subtab will be displayed under “Reports”.

In situations where multiple people use the same computer, the parameters entered in Steps 2–8 will be retained for 
each Windows® user account when the Plexor® Analysis Software is closed and reopened, so there is no need to repeat 
Steps 2–8 for subsequent runs unless the parameters change.

Note: If desired a forensic template for routine setups and for master template use can be created. Select “Export”, and 
save the .ftp file in a location of choice. For more information on template use, see Section 10.G.

1.	 Select “Set Normalization and IPC Parameters” in the Forensics menu.

2.	 In the dialog box that appears (Set STR Normalization and IPC Parameters; Figure 24), be sure that the box next 
to “disable volume normalization (show concentrations and Cq only)” is not checked. If this box is checked, STR 
normalization data will not be displayed in the subsequent forensic report. See Section 8.G.

3.	 Optional: If the DNA standards were defined in pg/µl (Section 8.B, Step 1), select the check box to set units as 
picograms. The default display is as nanograms.

4.	 Select the Autosomal STRs tab (Figure 24).

5.	 Enter the preferred DNA quantity per STR amplification reaction.
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Figure 24. The STR Normalization and IPC Parameters window.

6.	 Enter the minimum and maximum input volumes of sample (in µl) for each STR reaction. The limits for pipetting 
of sample should be defined in your laboratory. Minimum volume is generally defined by the limits of the pipettes 
being used and laboratory guidelines. Maximum volume will often be defined by the STR reaction volume or 
laboratory guidelines.

	 If a single sample volume for STR amplification setup is desired, narrow this range by entering the same volume 
for the minimum and maximum volumes. A broad range of input target quantities and volumes will limit the 
number of samples requiring dilution.

7.	 Enter the minimum and maximum sample DNA quantities (in ng/reaction, or pg/reaction if selected above), 
indicating the lowest and highest amounts of DNA known to produce acceptable STR profiles, as demonstrated 
through laboratory validation of the STR assays in conjunction with the Plexor® HY System.
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8.E.	 Normalization of DNA Quantification Results for Input into STR Reactions and Setup of IPC  
Parameters (continued)

8.	 Enter the preferred concentration (in ng/reaction, or pg/reaction if selected above) to which overconcentrated 
samples will be diluted. The concentration entered must achieve the preferred DNA quantity per reaction entered 
in Step 4 within the range of the minimum and maximum input volumes chosen in Step 6.

9.	 Select the Y-STRs tab, and repeat Steps 5–8.

10.	 Select the Internal PCR Control (IPC) tab (Figure 25). If desired, modify the IPC Cq threshold, which defines the 
acceptable difference between the IPC Cq values in DNA standards and samples. The default value is 2 cycles. If 
the IPC Cq value in a sample differs from the IPC Cq value in the DNA standard by more than 2 cycles, “Check 
IPC” will be displayed in the Forensic report for that sample. See Section 8.F for more details about interpreting 
IPC results and modifying this value.

	 Note: If desired you can create a forensic template for routine setups and master template use. Select “Export”, 
and save the .ftp file in a location of choice. For more information on templates use, see Section 10.G.
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Figure 25. The Internal PCR Control (IPC) tab.

11.	 After values for all three tabs [i.e., Autosomal STRs, Y-STRs and Internal PCR Control (IPC)] have been entered, 
select “OK”.

12.	 The Forensic report will be displayed (Figure 26).

	 Note: The Forensic Report can be modified to suit your preferences similarly to the other reports and legends 
(e.g., column shown, sort order, number format, averages, etc.). The display can be changed by right clicking on 
the table and selecting the desired options. The report can be sorted by any column by selecting the header of 
that column. Columns can be rearranged by clicking and dragging the header to the new location.
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Figure 26. The Forensics report.

Definitions and Forensic Report Interpretation

[Auto]: Concentration of total human autosomal DNA in a sample in ng/µl (or pg/µl if DNA concentrations were 
entered as pg/µl).

[Y]: Concentration of human male DNA in a sample in ng/µl (or pg/µl if DNA concentrations were entered as pg/µl).

[Auto]/[Y]: Ratio of total human autosomal DNA concentration to male (Y) DNA concentration. A very high ratio is 
indicative of a “male/female” mixture with minimal male DNA. If the male contributor is of interest, samples with a 
very high ratio may benefit from Y-STR analysis in addition to, or instead of, autosomal STR analysis. Laboratory 
validation of the Plexor® HY System in conjunction with the preferred autosomal and Y-STR systems is required to 
determine a meaningful value upon which to base this decision.

Note: Due to some individual-to-individual variation in copy number of the autosomal target and Y-chromosomal 
target, a single male DNA may not have an [Auto]/[Y] value of 1.0. Additionally, quantitative real-time PCR has 
inherent variation, especially with samples that have higher Cq values (i.e., samples with lower DNA concentrations). 
This variation can be reduced by performing replicate analysis. [Auto]/[Y] values in the range of 0.4 to 2 are commonly 
observed in single-source male samples.

The [Auto]/[Y] value is not intended to identify minor female contribution in a male sample. This ratio should be used 
to form guidelines to suggest when Y-STR analysis may be a beneficial supplement to autosomal STR analysis (i.e., 
[Auto]/[Y] between approximately 5 and 20) and when only Y-STR analysis is likely to produce a meaningful STR 
profile (i.e., [Auto]/[Y] ≥20). Laboratory validation of the Plexor® HY System, in conjunction with STR analysis, 
should be performed to determine these interpretation guidelines.
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8.E.	 Normalization of DNA Quantification Results for Input into STR Reactions and Setup of IPC  
Parameters (continued)

STR Dilution Status (Autosomal or Y): An indication of whether a sample contains DNA of adequate concentration 
to use directly in STR analysis or whether dilution is necessary. The status terms listed below are established by the 
values indicated in the Set STR Normalization and IPC Parameters window (Figure 24). Auto STR columns use 
autosomal quantification results and are intended to guide setup of autosomal STR reactions. Y-STR columns use 
Y-chromosomal quantification results and are intended to guide setup of Y-STR reactions.

•	 “No Target” indicates no DNA was detected

•	 “Underconc.” indicates that DNA was detected, but the minimum acceptable DNA quantity (ng or pg per 
reaction) cannot be achieved with the maximum volume that has been defined.

•	 “Below Target” indicates that the specified maximum volume of sample will deliver an acceptable quantity of 
DNA but less input DNA than the indicated preferred DNA quantity.

•	 “In Range” indicates that the preferred DNA quantity is achievable within the acceptable volume range.

•	 “Above Target” indicates that the specified minimum volume of sample will deliver an acceptable quantity of 
DNA but will deliver more input DNA than the preferred DNA quantity.

•	 “Overconc.” indicates that the maximum acceptable DNA quantity (ng or pg per reaction) cannot be achieved 
with the minimum volume that has been defined. Samples will need dilution.

STR Volume (Autosomal or Y): The volume (µl) of sample that should be used in STR analysis. Auto STR columns 
use autosomal quantification results and are intended to guide setup of autosomal STR reactions. Y-STR columns use 
Y-chromosomal quantification results and are intended to guide setup of Y-STR reactions.

STR Quantity (Autosomal or Y): The quantity (ng, or pg if selected) of sample that will be input into the STR 
reaction using the indicated STR Volume. Auto STR columns use autosomal quantification results and are intended to 
guide setup of autosomal STR reactions. Y-STR columns use Y-chromosomal quantification results and are intended to 
guide setup of Y-STR reactions.

STR Dilution Factor (Autosomal or Y): The dilution factor necessary to achieve the desired concentration 
indicated in the Set STR Normalization and IPC Parameters window (Section 8.E, Step 7). Only samples indicated as 
“Overconc.” will have a dilution factor listed. Auto STR columns use autosomal quantification results and are intended 
to guide setup of autosomal STR reactions. Y-STR columns use Y-chromosomal quantification results and are intended 
to guide setup of Y-STR reactions.

IPC Status: An indication of whether the difference between the sample’s Cq values for the IPC and DNA standard is 
greater than the designated threshold in the Set STR Normalization and IPC Parameters window (Figure 25). A 
difference of less than the designated threshold is indicated as “OK”; a difference greater than the threshold is indicated 
as “Check IPC”.



Promega Corporation · 2800 Woods Hollow Road · Madison, WI  53711-5399 USA · Toll Free in USA 800-356-9526 · 608-274-4330 · Fax 608-277-2516	 31
www.promega.com 	 TM294 · Revised 5/16

Curves Status: “OK” indicates the following:

•	 The sample, if defined as a standard, shows amplification.

•	 The sample, if defined as a no-template control, shows no amplification.

•	 If a melt peak is present, the Tm is within the expected range.

“Check STD”, “Check NTC” or “Check Melts” will be displayed if these criteria are not met.

Note: It is acceptable for the 0.0032ng/µl DNA standard to display “No” or “No Call” in the “Tm?” column. Verify that 
if any subthreshold peak is present in the melt curve, this peak is within the expected target melt temperature range.

8.F.	 Analysis of the Internal PCR Control (IPC)

The Internal PCR Control (IPC) is amplified and detected in the CR610 dye channel under PCR Curves. These data can 
provide an indication of potential inhibition that may have affected the quantification data (FAM™ and CO560 data). 
By comparing IPC Cq values for unknown samples with IPC Cq values for DNA standards, inferences regarding the 
presence of inhibitors can be made. Decreasing the IPC threshold above which a flag is shown (Figure 25) will increase 
the sensitivity to differences in the Cq values, while increasing the threshold will necessitate greater IPC Cq value 
differences to present the Check IPC flag.

Note: Data from samples are compared to data from DNA standards of similar autosomal Cq values. The IPC  
amplification is designed to be the most inhibition-sensitive or least robust amplification in the triplex.

•	 If the IPC Cq value of an unknown is several cycles higher than that of DNA standards with similar total DNA 
amounts, inhibition may have occurred and the quantification data are in doubt. Consider repurifying and  
requantifying the sample.

	 Note: High levels of total human DNA (≥10ng/µl) can cause a slight delay in the IPC crossing the cycle threshold 
(1–2 cycles).

•	 IPC Cq value differences can be used to automatically flag potential inhibition in the Forensics report as described 
in Section 8.E, Step 10.

Laboratory validation with relevant inhibitors should be performed to determine criteria for detecting inhibition.

8.G.	 Forensic Report Without Normalization

The quantification results can be reported without normalization of volumes. This report shows quantification results 
and IPC status and curves status columns.

1.	 Select “Set Normalization and IPC Parameters” in the Forensic menu.

2.	 Check the box to disable volume normalization (show concentrations and Cq values only).

3.	 Select the Forensic tab in the Reports menu.
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8.H.	 Data Export in a 96-Well Format

The quantification results can be exported in a 96-well format. The exported file is an Excel spreadsheet, which can be 
used for automated PCR setup. This export is only possible after the instructions in Section 8.E are performed.

1.	 Select “Export 96-well Concentration” in the Forensics menu.

2.	 Select “Autosomal Concentrations” for the autosomal results, enter a file name and select “Save”.

3.	 Select “Y Concentrations” for the Y results, enter a file name and select “Save”.

8.I.	 Supplemental Reports

In addition to the Forensics report described in Section 8.E, the Plexor® Analysis Software includes five report options: 
“Sample Details”, “Thresholds”, “Baseline Regions”, “Run Info” and “Import Files”, which are included as subtabs in 
the Reports tab. To view these report options, select the Reports tab. Information is presented in a tabular format that 
can be copied, saved or printed using the provided icons. The saved data can be opened using Microsoft Excel®.

Sample Details: The sample details report includes well location, sample name, dye channel, cycle threshold, thermal 
melt temperature, concentration (if applicable), whether the sample has the expected Tm and the number of melt curves 
that cross the melt threshold line (Figure 27).

A sample with a Cq value of “N/A” has an amplification curve that did not cross the amplification threshold.
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Figure 27. The Sample Details tab.

Thresholds: The thresholds report includes the numerical values for the thresholds in the current analysis (Figure 28). 
This information can be used to develop an analysis template for assays where the same or similar thresholds will be 
used on a routine basis. See Section 10.G for more information about creating an analysis template.

Baseline Regions: The baseline regions report includes the numerical values for the cycle number used in each 
sample (Figure 29).
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Figure 28. The Thresholds tab.

68
11

TA

Figure 29. The Baseline Regions tab.

Run Info: The run info report includes information from the data import (Figure 30).

Import Files: The import files report includes information on the data import files (Figure 31).
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Figure 30. The Run Info tab.
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8.I.	 Supplemental Reports (continued)
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Figure 31. The Import Files tab.

8.J.	 Saving and Printing the Analysis File

1.	 The Plexor® Analysis Software saves the analysis as an *.aan file. The current analysis can be saved at any time by 
selecting “Save Analysis File (.aan)” in the File menu.

2.	 Selected wells can be exported into a new analysis file. In the File menu, select “Export Selected Wells as New 
Analysis File (*.aan)”.

3.	 The analysis screen can be printed or saved as a screenshot. In the File menu, select “Save a Screenshot (.png)” 
or “Print a Screenshot”.

4.	 A run template and analysis template from an existing analysis can be exported and used in future analysis  
(Section 10.G).

9.	 Troubleshooting

Symptoms	 Causes and Comments
Flat amplification curve in the amplification 	 Template was degraded or of insufficient quantity. Verify the  
curves window for autosomal and Y channels 	 integrity of the DNA template by electrophoresis.

but not the IPC. The IPC Cq value of the sample 	 Be sure that the reactions were assembled correctly.

in question was similar to the Cq value of the 	 Thermal cycler was programmed incorrectly. Verify cycle time  
DNA standards (no apparent amplification for 	 and temperatures (Section 5.C).

the autosomal and Y targets)	� Data collection settings were incorrect. Data collection must 
occur during the extension step. The extension time must be 
sufficient for data collection. Verify the data collection settings.

	� The wrong dye or detector was selected. Be sure the selected 
detectors are appropriate for the fluorescent dyes used.

	� The passive reference was set incorrectly. Be sure the passive 
reference is set as “IC5” (Figure 14).

	 The scale of the Y axis was inappropriate. If the scale of the Y  
	 axis is too broad, the change in fluorescence may not be visible.  
	 Adjust the scale of the Y axis.
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Symptoms	 Causes and Comments
Flat amplification curve in the amplification 	 Amplification inhibitor is present in the DNA template. Reduce 
curves window for all channels (i.e., no Cq values) 	 the concentration or volume of the template in the reaction.  
or for autosomal and Y DNA with higher or 	 Repeat the DNA purification if necessary

no Cq values for the IPC	� Sample well(s) did not receive reaction mix. Examine the plate 
to identify any empty wells. Return to the Plate Setup tab 
(Figure 9), and redefine the samples, taking care not to define 
any empty wells. Reexport and reanalyze data (Section 6).

	� The scale of the Y axis was inappropriate. If the scale of the Y 
axis is too broad, the change in fluorescence may not be visible. 
Adjust the scale of the Y axis.

	� The Plexor® HY 2X Master Mix may have lost activity. Be sure to 
store the Plexor® HY System at –20°C to avoid loss of enzyme 
activity.

	� The Plexor® HY 20X Primer/IPC Mix may have been degraded. 
Minimize the number of freeze-thaw cycles.

Increasing fluorescence over time	� Make sure that the IC5 passive reference is selected during data 
import.

	� The baseline region was set in a region with significant fluores-
cence fluctuation. The baseline within the baseline region should 
be flat. Manually adjust the baseline region (Section 10.C).

	� The baseline region was set too close to the signal change. 
Manually adjust the baseline region (Section 10.C).

No melt curve observed in the melt curves 	 Poor amplification. See causes and comments for “Flat  
window	� amplification curve in the amplification curves window” 

symptoms above.

	� Problems with data export or instrument analysis have occurred. 
Review the instructions for data export and instrument setup.

	� Data collection settings were incorrect. Verify the thermal	
�cycling program and data collection settings are correct  
(Section 5.C).

	� Incorrect files were imported. Be sure to import the proper 	
files containing related amplification data and dissociation 	
data.

	� Instrument was programmed incorrectly. Verify that the 	
thermal cycling program is correct (Section 5.C).
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9.	 Troubleshooting (continued)

Symptoms	 Causes and Comments
No melt curve observed in the melt curves	 Sample well(s) did not receive reaction mix. Examine the plate  
window (continued)	� to identify any empty wells. Return to the Plate Setup tab 

(Figure 9), and redefine the samples, taking care not to 
defineany empty wells. Reexport and reanalyze the data  
(Section 6).

	� Melt Curve display was changed to “Gaussian Fit” mode, and 
selected samples do not meet the melt threshold. If “Gaussian 
Fit” mode is selected, the Plexor® Analysis Software draws as 
straight lines (zero slope, zero y-intercept) those curves that did 
not meet the melt threshold at the time of import, at the time of 
opening the *.aan file, or at the time of switching from “Raw 
Data” view to the “Gaussian Fit”. This indicates that these 
curves were not considered for melt peak calling (Exp Tm?). 
Switch the melt curve view to “Raw Data”.

Variability in signal among replicate samples	 Calibrate your pipettes to minimize variability when pipetting.

	� Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; we recommend using a sample volume of 2µl or 
higher. If necessary, dilute the template so that larger volumes 
are pipetted.

	� Some variation is normal. A difference of 1–2 cycles for the Cq 
values of replicates is within the normal variation associated 
with an exponential amplification reaction. Cq variation should 
be <2 cycles for replicates.

	� There will be statistical variation in the amount of template in a 
reaction with targets present at low copy number. Poisson 
distribution predicts difficulty associated with reliable detection 
of dilute samples with few target molecules.

	� Mixing was inadequate. Vortex reagents to mix well prior to 
pipetting.

	� Plate performance can differ between manufacturers. Use 
plasticware recommended by the instrument manufacturer.

	 Perform a background check as directed by the manufacturer.

	� Viscous samples (e.g., high-molecular-weight genomic DNA) are 
difficult to pipet accurately. Dilute the DNA template. 

	� Store the DNA at 4°C overnight to improve sampling  
consistency.
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Symptoms	 Causes and Comments
Variability in signal among replicate samples 	 The baseline region was not set correctly. The baseline should be  
(continued)	�  flat. The baseline region can be adjusted manually for each well 

to account for sample-to-sample variation (Section 10.C).

	� The plate was not completely sealed. Carefully seal the plates to 
avoid evaporation.

Fluorescence decrease observed in the 	 Reactions were contaminated with target DNA. Human DNA   
no-template control reaction	� contamination will produce a melt product similar to that of the 

DNA standard amplifications. Clean workstations and pipettes 
with a mild bleach solution before and after use. Use new 
reagents and solutions. Take precautions to prevent  
contamination. Use separate bench spaces and pipettes when 
handling DNA.

	� Decrease the cycle number to reduce accumulation of  
nonspecific amplification products.

Vertical fluorescence spikes or significant 	 Consult the instrument manufacturer’s user’s guide for  
“noise” in the amplification curve	� information about potential instrument problems that can cause 

spikes or noise.

	� No amplification or poor amplification for the entire plate. Poor 
amplification can lead to improper data scaling, making 
fluorescence measurements appear erratic. See possible causes 
and comments for “Flat amplification curve in the amplification 
curves window” symptoms above.

	� The passive reference was set incorrectly. Be sure the passive 
reference is set as “IC5” (Figure 14).

	� Sample well(s) did not receive reaction mix. Examine the plate 
to identify any empty wells. Return to the Plate Setup tab 
(Figure 9), and redefine the samples, taking care not to define 
any empty wells. Reexport and reanalyze the data (Section 6).

Small signal change in amplification and melt	 No amplification or poor amplification. See causes and  
curves	� comments for “Flat amplification curve in the amplification 

curves window” above.

	� Incorrect dye was selected. Verify the appropriate dye was 
selected.

	� The scale of the Y axis of the amplification curve was affected by 
other reactions on the plate. A high fluorescent signal for one or 
more reactions can cause the scale of the Y axis of the amplifica-
tion curve to be too high to see changes in some data. Adjust the 
scale of the Y axis to accommodate samples with smaller changes 
in fluorescence. See Section 10.F.



38	 Promega Corporation · 2800 Woods Hollow Road · Madison, WI  53711-5399 USA · Toll Free in USA 800-356-9526 · 608-274-4330 · Fax 608-277-2516
TM294 · Revised 5/16	 www.promega.com

9.	 Troubleshooting (continued)

Symptoms	 Causes and Comments
Small signal change in amplification and melt 	 The passive reference was set incorrectly. Be sure the passive  
curves (continued)	 reference is set as “IC5” (Figure 14).

	� Sample well(s) did not receive reaction mix. Examine the plate 
to identify any empty wells. Return to the Plate Setup tab 
(Figure 9), and redefine the samples, taking care not to define 
any empty wells. Reexport and reanalyze the data (Section 6).

Nonlinear standard curve, low R2 values ≤0.98	� Be sure that the DNA standard is completely thawed and mixed 
well before use. Store the DNA standard at 4°C overnight to 
improve sampling consistency.

	� Be sure dilutions of the DNA standard are well mixed before 
removing each aliquot for the serial dilution. Change pipette tips 
between each dilution step.

	 Calibrate your pipettes to minimize variability when pipetting.

	� Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; we recommend using a sample volume of 2µl or 
higher. If necessary, dilute the template so that larger volumes 
are pipetted.

	� Adjust the baseline region. The baseline region can be manually 
adjusted for each reaction. See Section 10.C.

	� Some variation is normal. Perform duplicate or triplicate 
reactions for the standard curve to minimize the effect of this 
variation.

	� There will be statistical variation in the amount of template in  
a reaction with the DNA target present at low copy number. 
Perform duplicate or triplicate reactions for the standard curve. 
Remove the 0.0032ng/µl dilution of the DNA standard from the 
standard curve by changing the sample type to “unknown”.

	� An error was made during dilution of the DNA standard. Verify 
all calculations, and repeat dilution of the DNA standard. Do not 
pipet volumes <1µl.

	� Incorrect concentration values were entered in the Plexor® 
Analysis Software. Verify the concentrations for all samples used 
to generate the standard curve.

	� Reactions were contaminated with target DNA. Clean  
workstations and pipettes with a mild bleach solution before  
and after use. Use new reagents and solutions. Take precautions 
to prevent contamination.
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Symptoms	 Causes and Comments
Nonlinear standard curve, low R2 values ≤0.98	 The plate was not completely sealed. Carefully seal the plates to  
(continued)	 avoid evaporation.

	� Aberrant fluorescence can be caused by writing on plates, 
contamination, fingerprints, etc. Do not write on the plate. Use 
caution when handling plates. Wear gloves. Do not place plates 
on surfaces that might be contaminated with fluorescent 
material. If you suspect contamination of the benchtop, thermal 
cycler block or any other area, clean it thoroughly.

Slope is outside of the range specified in 	 No amplification or poor amplification. See causes and  
Section 8.D	� comments for “Flat amplification curve in the amplification 

curves window” symptoms above.

	� Nonspecific amplification can become a problem in later 
amplification cycles for samples containing small amounts of 
target template. Decrease the number of amplification cycles.

	� An error was made during dilution of the DNA standard. Verify 
all calculations, and repeat dilution of the DNA standard. Do not 
pipet volumes <1µl.

	� Incorrect concentration values were entered in the Plexor® 
Analysis Software (Section 8.B). Verify the concentrations for all 
samples used to generate the standard curve.

	� There was variability or inaccuracy when pipetting reaction 
components. Calibrate pipettes to improve accuracy.

	� There will be statistical variation in the amount of template in  
a reaction with the DNA target present at low copy number. 
Perform duplicate or triplicate reactions for the standard curve. 
Remove the 0.0032ng/µl dilution of the DNA standard from the 
standard curve by changing the sample type to “unknown”.

Unable to import data. An error like “Expecting 	 The data has been altered after export from the real-time PCR 
NEWLINE, found’’ or “Unexpected Token Error” 	 instrument software. Any alteration of this data is likely to  
is encountered	� change the formatting and can cause import errors. Do not open 

the exported files with other software programs.

Data display appears abnormal in the Plexor® 	 Be sure that the display settings for the computer are set to 
Analysis Software (the screen appears 	 32-bit color, rather than 16-bit color, when using the Plexor® 
compressed, lines are replaced with dots, etc.)	 Analysis Software.
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10.	 Appendix

10.A.	Plexor® Analysis Software Operating System Compatibility

The Plexor® Analysis Software is fully compatible with Windows® 7. The Plexor® Analysis Software is not compatible 
with Macintosh® operating systems.

Be sure that the display settings for the computer are set to 32-bit color, rather than 16-bit color, when using the 
Plexor® Analysis Software.

10.B.	Quantification Using Large Sample Volumes

You may wish to increase input volumes to increase sensitivity or match the input volume of subsequent STR assays. 
Laboratory validation is required for any protocol modifications. The Plexor® HY System allows up to 9µl of input 
material per reaction. The sample volume can be increased as long as the final reaction volume remains constant. The 
reaction volumes must be the same for both the DNA standards and unknown samples. This allows the DNA 
standards to be considered as a concentration (in ng/µl) instead of input amount in ng (ng/µl × volume).

Table 4 shows the necessary serial dilutions to perform an alternative standard curve using 5µl input volumes and DNA 
standard concentrations in the range of 1.28pg/µl to 20ng/µl.

Table 4. Serial Dilution of the Plexor® HY Genomic DNA Standard for the Alternative Standard Curve 
(assumes 5µl of DNA per reaction).

Concentration Volume of DNA Volume of TE–4 Buffer

20ng/µl Use 10µl of DNA 15µl

4ng/µl 10µl of 20ng/µl dilution 40µl

0.8ng/µl 10µl of 4ng/µl dilution 40µl

0.16ng/µl 10µl of 0.8ng/µl dilution 40µl

0.032ng/µl 10µl of 0.16ng/µl dilution 40µl

0.0064ng/µl 10µl of 0.032ng/µl dilution 40µl

0.00128ng/µl 10µl of 0.0064ng/µl dilution 40µl

Reaction Setup

Prepare the reaction mix by combining the Water, Amplification Grade, Plexor® HY Reaction Mix and Plexor® HY 
Primer/IPC Mix as indicated in Table 5.

If the sample volume is increased, decrease the volume of water added to each reaction so that the final reaction volume 
is constant.

Proceed with reaction setup as described in Section 4.B, but dispense 15µl of reaction mix to wells, rather than 18µl. 
Add 5µl of sample DNA or DNA standard to each reaction. Add 5µl of TE–4 buffer to the NTC reactions.
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Table 5. Preparation of Reaction Mix for Quantification Assays (5µl of template per reaction).

Component Volume (Per Reaction)

Plexor® 2X Master Mix 10µl

Water, Amplification Grade 4µl

Plexor® HY 20X Primer/IPC Mix 1µl

Final volume 15µl

Data Analysis

During sample definition (Section 8.B), the dilution series must be modified to reflect the change in concentration of 
the DNA standards. When using 5µl input volumes, note that the dilution series is a decreasing, fivefold dilution series 
with “20” as a starting concentration or an increasing fivefold dilution series starting with “0.00128”, as appropriate 
for the plate layout used.

10.C.	Adjusting the Baseline Region (Optional)

The Plexor® Analysis Software automatically sets the baseline region for each sample during import. The baseline is set 
in a flat region of the amplification curve before product accumulation (i.e., the downward inflection). Manual 
adjustment of the baseline region is possible for each sample but rarely necessary. Manual adjustment might be 
required for runs where the baseline region is set during or after amplification (i.e., not within the flat part of the 
amplification curve; Figures 32 and 33).
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Figure 32. An amplification window showing an improper baseline region with an improper baseline 
upper limit.
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Figure 33. An amplification window showing an improper baseline region with improper upper and 
lower limits.
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10.C.	Adjusting the Baseline Region (Optional; continued)

In some instances, manual adjustment may provide optimal representation of the data. This may include samples with 
excessive noise, bleedthrough or early Cq values or situations where the real-time instrument shows early signal 
fluctuation. Figures 32 and 33 show examples of data with improperly set baseline regions that should be adjusted 
manually. In Figure 32, the upper limit of the baseline region (21.1) is within the visible signal change. The Cq value 
has been erroneously increased to accommodate this baseline region. In general, the upper bound of the baseline 
region is set several cycles before the amplification curve crosses the threshold. In this example, the difference between 
the upper baseline region bound and Cq value is only 0.7 cycles. In Figure 33 the lower and upper limits of the baseline 
region (32.0 and 35.0, respectively) are set after the visible signal change. The baseline region must precede the visible 
amplification. A properly set baseline region with appropriate lower and upper limits is shown in Figure 34.
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Figure 34. An amplification window showing the proper baseline region and baseline upper and lower 
limits.

1.	 Select the PCR Curves tab.

2.	 Select the Display and Manually Adjust Baselines icon: 
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3.	 Select the samples to be adjusted using the well selector.

	 Note: The baseline region can be adjusted for individual samples or groups of samples by selecting or dragging 
the lower and upper limits. The shading in the baseline region will be gray if the selected samples do not share a 
common baseline region (Figure 34). The baseline is set independently for each dye.

4.	 Adjust the upper limit of the baseline region for each sample so that the upper limit is approximately 5 cycles  
before the decrease in fluorescence and in an area where the baseline is flat. The Cq values for selected samples 
are displayed in the table to the right of the graph. The Cq value may change when the limits are changed. See 
Notes 1 and 2.

5.	 If necessary, adjust the lower limit to a region that creates the flattest baseline given the selected upper limit.

6.	 Optional: The amplification threshold is based on noise within the baseline region for all samples. When 
manual baseline adjustments are complete, consider recalculating the amplification threshold for all samples. 
Select all samples, and in the Edit menu, select “Set Amp Threshold from Selected Samples” (Section 10.D).  
See Notes 3 and 4.
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Notes:

1.	 A maximum upper limit of 35 cycles can be used for samples without a Cq value (e.g., no-template control).

2.	 Samples with similar Cq values can be adjusted simultaneously by highlighting multiple wells.

3.	 To reset the baselines for a selected set of samples, select the samples in the well selector, and in the Edit menu, 
select “Set Baselines for Selected Samples”.

4.	 The baselines for all samples can be reset to the automatic setting by selecting the Reset Baselines and Amp 
Thresholds icon: 
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10.D.	Adjusting the Amplification Threshold (Optional)

The amplification threshold is used to determine the Cq value for the samples (Figure 35). The default amplification 
threshold is based on the variation (noise) in the baseline regions of all samples. It is determined by calculating the 
mean and standard deviation of all RFU values in the baseline regions and setting the threshold to 10 standard 
deviations below the mean.

Optional: The amplification threshold may be reset to change the sensitivity in detecting the amplification product.
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Figure 35. The amplification threshold.

1.	 To adjust the amplification threshold based on a selected set of samples, highlight the desired samples in the well 
selector. In the Edit menu, select “Set Amp Threshold From Selected Samples”. Enter the number of standard 
deviations of the background within the baseline region to use. The default is 10 standard deviations.

2.	 To manually adjust the threshold, place the cursor over the threshold, and drag the line to the desired location. 
Alternatively, double-click on the threshold, and enter the desired value.

! 	 Changes made to the amplification threshold will apply to the entire data set within the same dye channel, 
including those samples that were not selected.

3.	 Optional: The amplification threshold is based on noise within the baseline region for all samples. When 
manual baseline adjustments are complete, consider recalculating the amplification threshold for all samples.  
See Notes 1 and 2.
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10.D.	Adjusting the Amplification Threshold (Optional; continued)

Notes:

1.	 The amplification threshold can be reset based on all samples. Select all samples, and in the Edit menu, select 
“Set Amp Threshold from Selected Samples”.

2.	 The amplification threshold and baselines for all samples can be reset to the automatic setting by selecting the 
Reset Baselines and Amp Thresholds icon: 
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10.E.	Adjusting the Melt Threshold (Optional)

Optional: The melt threshold may be reset to change the sensitivity in detecting the amplification product. See  
Notes 1–4. The default melt threshold is set at 25% of the signal change for the sample within the set that has the 
greatest change in signal. In some instances, the sample(s) used to set this threshold may not be typical of the data set.

To adjust the melt threshold line based on a selected set of samples, highlight the desired samples in the well selector. 
In the Edit menu, select “Set Melt Threshold From Selected Samples”. Enter the desired percentage of signal change.

To manually adjust the melt threshold line, place the cursor over the threshold line, and drag the line to the desired 
location. Alternatively, double-click on the threshold line, and enter the desired threshold value.

Notes:

1.	 The melt threshold is the level of signal that must be reached for the Plexor® Analysis Software to “call” the melt 
results. Target Tm indicators are included in the table to the right of the amplification and melt curve windows.

2.	 A “Yes” or “No” in the Tm? column indicates whether a sample Tm is within the expected target melt temperature 
range. A “No Call” in this column indicates that the melt curve displays the correct expected target melt tempera-
ture, but there is insufficient amplification product to cause the amplification curve to cross the melt threshold.

3.	 The “Tm#” is the number of peaks that cross the melt threshold line. More than one peak indicates heterogeneous 
amplification products. This may be due to nonspecific amplification.

4.	 Changes made to the melt threshold line will apply to the entire data set within the same dye channel, including 
those samples that were not selected.

10.F.	 Adjusting the Y Axes of the Amplification and Thermal Melt Curves (Optional)

The scales of the Y axes for the amplification curve and melt curve in an experiment are determined by the sample that 
yields the most amplification product (i.e., the sample with the greatest decrease in signal). These scales are set for the 
entire data set.

If you toggle the “Rescale Graphs From Selected Wells” command (from the Window pull-down menu), the scale of the 
Y axes will be adjusted automatically based only on the wells currently selected for viewing.

The scale of the Y axis can be set manually by double-clicking on the Y axis of the graph and entering the new value in 
the pop-up window. This change will alter the scale for the entire data set.
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10.G.	Templates for Routine Setups Using a Master Template (Optional)

You may define templates for creating a Master Template to import all the other templates for routine analysis. The 
Master Template option is available only with Plexor® Analysis Software v1.6.0 or higher. Use the Master Template 
when the same instrument and software version, plate layout and analysis parameters are routinely used in the 
laboratory.

A Master Template will contain all the other templates you can create for routine analysis (e.g., assay template, run 
template, analysis template, forensic template). Creating a Master Template will allow you to import and analyze data 
using the Plexor® Analysis Software in one step. The Master Template option is available only with Plexor® Analysis 
Software, version 1.6.0 or higher. Use the Master Template when the same instrument and software version, plate 
layout and analysis parameters are routinely used in the laboratory.

Creating a Master Template

To create a master template the “Assay Template”, “Run Template”, “Analysis Template” and “Forensic Template” must 
be created and saved first.

1.	 In the Plexor® Analysis Software, make sure the “Use Master Template On Import” option in the File menu is 
unchecked.

2.	 Import the new run following the instructions provided in Section 7.

3.	 Choose instrument, targets, dyes and data collection stages (Step 1). See Figure 36.
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Figure 36. The Assay Setup screen.
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10.G.	Templates for Routine Setups Using a Master Template (Optional; continued)

4.	 Select “Export” to save the assay template as “Chosen Assay Template.atp”.

5.	 Optional: Enter operator name and other details (Step 2).

6.	 Import data file (Step 3). See Figure 37.
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Figure 37. The File Import screen.

7.	 Select “Finish”.

8.	 Define DNA standards, samples and analysis parameters as described in Section 8.

9.	 Analyze the data with the Plexor® Analysis Software as described in Section 8.
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10.	 In the File menu select “Export Run Template” to save the run template as Chosen Run template.rtp (Figure 38).

11.	 In the File menu select “Export Analysis Template” to save the analysis template as Chosen Analysis template.ntp 
(Figure 38).
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Figure 38. The Plexor® Analysis Software File menu. Check “Export Run Template (.rtp)” and “Export Analysis 
Template (.ntp)”.
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10.G.	Templates for Routine Setups Using a Master Template (Optional; continued)

12.	 In the Forensic menu, select Forensics and Set Normalization and IPC Parameters (Figure 39); edit as necessary. 
Select “Export”, and save as Chosen Forensic template.ftp.
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Figure 39. The Set STR Normalization and IPC Parameters screen. Select “Export” and save as Chosen 
Forensic template.ftp.
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13.	 Make sure the “Use Master Template on Import” option in the File menu is checked (Figure 40).
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Figure 40. The Plexor® Analysis Software File menu. Check “Use Master Template On Import”.

14.	 Exit the Plexor® Analysis Software when the templates are created and saved.
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10.G.	Templates for Routine Setups Using a Master Template (Optional; continued)

15.	 Select “Import” in the File menu. The Master Template screen will open (Figure 41). In the Assay Setup section 
of the Master Template screen, browse to and choose the saved Assay Template file (.atp).

16.	 Under “Advanced Options” at the bottom of the Master Template screen, browse to and select all saved chosen 
templates (.rtp, .ntp, .ftp) in the appropriate field as shown in Figure 41.

17.	 Select “Export” and save the newly created template (.mtp).

18.	 In the “Import” section of the Master Template screen, browse to the data file and import the file.

19.	 Add run information, such as experiment name or operator name, if necessary.

20.	 Select “Finish”.
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Figure 41. The Master Template screen.

Using a Master Template

1.	 Make sure the “Use Master Template on Import” option in the File menu is checked.

2.	 Select “Import”, and choose the Master template.mtp file saved in Step 17.

3.	 In the “Import” section of the Master Template screen, browse to the data file and import the file.

4.	 Add run information if necessary.

5.	 Select “Finish”.
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10.H.	Templates for Routine Setups Without Using a Master Template

If you do not wish to use the master template, you may define two templates that can be used to apply standard plate 
configuration and assay parameter information to routine experiments: “Run Template” and “Analysis Template”, 
respectively. You can define and apply these templates during the run data import process (at Step 3 – File Import;  
see Figure 16 in Section 7); you also can specify that templates be applied automatically during import.

Templates also can be produced (exported) or applied (imported) from the analysis desktop using commands from the 
“File” pull-down menu.

Run Template: A run template is used to assign sample types, sample colors and concentrations of DNA standards 
(Figure 42). If you routinely use the same setup for plates of standards and unknowns, a run template can be created, 
stored and applied to subsequent runs.
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Figure 42. A run template.

1.	 To define or modify a template during run data import, in Step 3 – File Import, in the “Advanced Options”  
section, click the “Edit” button under “Run Template”.

2.	 Assign colors, sample types and DNA concentrations to the standards in the Plate Setup tab.

	 Note: To import an existing *.rtp file that contains a saved plate configuration, select “Import” and browse to 
that file.

3.	 Use the Sample Names tab to label your samples. Simply select the sample you wish to name and start typing.

4.	 Select “Export” to save the plate configuration to a *.rtp file for later use.
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10.H.	Templates for Routine Setups Without Using a Master Template (continued)

5.	 If you wish to have the current template automatically applied to future datasets during import, click on “De-
faults...” at the top of the window and then select “Save as Default”. The Run Template specified as the default 
will then be named in the “Advanced Options” section of the “Step 3 – File Import” window.

6.	 Select “OK”. Template parameters will be loaded and can be edited if desired.

Run Templates also can be produced or applied post-import. To save a Run Template based on the plate parameters 
defined in the assay currently displayed on the Analysis Desktop, click on the “File” pull-down menu, and select 
“Export Run Template (.rtp)”. To apply a saved Run Template to the assay currently displayed on the Analysis Desktop, 
click on the “File” pull-down menu, and select “Apply Run Template (.rtp)”.

Analysis Template and Definition of Analysis Functions: The analysis template is used to optimize the analysis 
settings for the experiment. A template can be set up to include the expected target melt temperature for each reaction. 
The expected target melt temperature should be determined for each real-time instrument. We recommend the default 
settings for all other analysis parameters.

1.	 To define or modify a template during run data import, in Step 3 – File Import, in the “Advanced Options”  
section, click the “Edit” button under “Analysis Template”.

2.	 Enter the desired values for the “Expected Target Melt Temperature (Tm)” for each dye used (Figure 43).

Notes:

1.	 Descriptions of the analysis details are provided below.

2.	 To import an existing *.ntp file that contains the saved default settings, select “Import” and browse to that 
file (Section 7, Step 12).

3.	 Select “Export” to save the Analysis Template as  a *.ntp file for later use.

4.	 If you wish to have the current template automatically applied to future datasets during import, click on 
“Defaults...” at the top of the window and then select “Save as Default”. The Analysis Template specified as the 
default will then be named in the “Advanced Options” section of the “Step 3 – File Import” window.

5.	 Select “OK”.

Analysis Templates also can be produced or applied post-import. To save an Analysis Template based on the  
parameters defined in the assay currently displayed on the Analysis Desktop, select “Export Analysis Template (.atp)” 
from the File menu. To apply a saved Analysis Template to the assay currently displayed on the Analysis Desktop,  
select “Apply Analysis Template (.atp)” from the File menu.

Default Amplification Threshold (RFU) Baseline Noise Standard Deviations: The Plexor® Analysis Software 
has a user-definable amplification threshold that determines the RFU value at which sample Cq values are called.  
This threshold value is based on the variation (noise) in the baseline regions of all samples and is determined by 
calculating the mean and standard deviation of all RFUs in baseline regions. The threshold is set at a specified number 
of standard deviations below the mean. The default threshold is 10 standard deviations but can be changed in the 
analysis template or recalculated at any time by using the Set Amp Threshold from Selected Samples option in the Edit 
menu (Section 10.D).
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Figure 43. The Analysis Defaults tab.

Default Melt Threshold –d(RFU)/dT Percentage: The melt curve allows you to distinguish amplification products 
with different sequences and lengths. In the absence of nonspecific amplification products, the melt curve will have one 
peak. Each sample has a melt curve, from which a Tm can be determined. A Tm value is reported for all melt curves that 
cross the melt threshold and are present within the expected melt temperature range. The melt threshold represents the 
–d(RFU)/dT value that is required before a Tm value is reported for a sample. A sample’s Tm value is calculated as the 
temperature at which the melt curve has the lowest (i.e., the most negative) –d(RFU)/dT value.

The default melt threshold –d(RFU)/dT percentage is preset at 25.0% and can be set between 0.0 and 100.0%. This 
value is used by the software to calculate the melt threshold value. The Tm threshold value is defined as a percent of the 
–d(RFU)/dT value for the sample with the lowest –d(RFU)/dT value in the data set.

See Section 10.E for instructions to adjust the melt threshold.

Expected Target Melt Temperature: The expected target melt temperature is the melt temperature of the correct 
PCR product (Section 8.C). The default expected target melt temperature is 90°C.

Target Tm Upper Bound: The target Tm upper bound is the number of degrees Celsius above the expected target melt 
temperature at which a sample Tm is considered to be suspect. The default target Tm upper bound is +1.5°C.

Target Tm Lower Bound: The target Tm lower bound is the number of degrees Celsius below the expected target melt 
temperature at which a sample Tm is considered to be suspect. The default target Tm lower bound is –1.5°C.
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10.I.	 Icon Definitions

	 Assign Color (shortcut = “q”)

The Assign Color function allows you to select a color in which a sample is displayed. This color selection is associated 
with those samples in the amplification and melt curves, well selector and any reports. Select one or more wells using 
the well selector, then select this button to choose the desired color for the selected samples. Sample color does not 
change the analysis of a sample in any way.

	 Assign Unknown (shortcut = “w”)

The Assign Unknown function allows you to assign the sample type “Unknown” to all selected samples. Select one or 
more wells using the well selector, then select this button to assign the sample type “Unknown”. Unknown samples are 
displayed as open squares in the well selector. They are labeled “Unknown” in reports. When included in a standard 
curve, the concentrations of unknown samples will be calculated and reported if a Cq value is present.

	 Assign NTC (shortcut = “e”)

The Assign NTC function allows you to assign the sample type “No Template Control” to all selected samples. Select 
one or more wells using the well selector, then select this button to assign the sample type “No Template Control”. 
No-template control reactions are displayed as diamonds in the well selector. They are labeled as “No Template 
Control” in reports. When included in a standard curve, the concentration of sample in the no-template control 
reaction will be calculated and reported if a Cq value is present.

	 Assign Positive Control (shortcut = “t”)

The Assign Positive Control function allows you to assign the sample type “Positive Control” to all selected samples. 
Select one or more wells using the well selector, then select this button to assign the sample type “Positive Control”. 
Positive control samples are displayed as hexagons in the well selector. They are labeled “Positive Control” in reports. 
When included in a standard curve, the concentrations of positive control samples will be calculated and reported if a 
Cq value is present.

	 Assign Standard (shortcut = “r”)

The Assign Standard function allows you to assign the sample type “Standard” to all selected samples. Select one or 
more wells using the well selector, then select this button to assign the sample type “Standard”. Only samples that have 
been assigned a type of “Standard” will be used to generate the best-fit line in standard curves. All DNA standards must 
be assigned a concentration by the user when they are defined as a standard. Concentrations may be entered in 
standard format (0.01, 0.1, 1, 10, 100, 1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3, etc.). See 
Section 8.B. The software does not accept commas in the concentration assignments. Standards are displayed as circles 
in the well selector and standard curve graphs. They are labeled “Standard” in reports.
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	 Create Dilution Series (shortcut = “f”)

The Create Dilution Series function creates a full dilution series within a row or column of wells. Select the wells that 
contain a dilution series of the DNA standard, then select “Create Dilution Series”. You must enter the initial DNA 
concentration of the series, the dilution factor and whether the series is increasing or decreasing (Figure 20).  
Concentrations may be entered in standard format (0.01, 0.1, 1, 10, 100, 1000, etc.) or scientific format (1e-2, 1e-1, 
1e0, 1e1, 1e2, 1e3, etc.). The software does not accept commas in the concentration assignments.

All selected wells will be assigned the sample type “Standard” with a corresponding concentration. This function can 
only be performed with DNA standards in adjacent rows or columns. Using this function produces the same result as 
selecting each well in the series individually and assigning it the sample type “Standard” with the appropriate concen-
tration. Only samples that have been assigned the sample type “Standard” will be used to generate the standard curves.

	 Add Standard Curve (shortcut = “d”)

The Add Standard Curve function fits the experimentally measured Cq values and user-entered concentration values for 
DNA standards to a straight line using the least mean squares method. It will calculate the DNA concentrations of 
unknown samples, positive control reactions and no-template control reactions from their measured Cq values using the 
equation for the best-fit line. Any sample with a concentration of “N/A” on the report or elsewhere did not cross the 
amplification threshold, so the concentration of that sample cannot be calculated.

Select all of the samples you wish to use as standards, as well as all other samples for which you wish to calculate 
concentrations. Choose “Add Standard Curve” from the Edit menu, and type “d” or select the Add Standard Curve icon 
on the toolbar.

You may create as many standard curves as you wish for a single set of data, but no sample can be used to generate 
more than one standard curve. It is not possible to add samples to an existing standard curve, but a new curve can 
easily be constructed with a new selection. This action will remove the existing standard curve and generate the new 
standard curve using the samples you have selected. You may generate the original standard curve at any time.

	 Remove Standard Curve (shortcut = “c”)

The Remove Standard Curve function removes the standard curve on the tab that is currently selected. This function is 
only available in the Standard Curves tab.

5
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The Display and Manually Adjust Baselines function allows you to set the baseline range for a sample or set of samples. 
Select one or more wells using the well selector, then select this button. See Section 10.C.
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	 Reset Baselines and Amp Thresholds

The Reset Baselines and Amp Thresholds function allows you to reset the baseline range and amplification threshold 
for all samples. See Sections 10.C and 10.D.
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10.K.	Composition of Buffers and Solutions

TE-4 buffer (10mM Tris-HCl, 0.1mM EDTA [pH 8.0])

	 1.21g	 Tris base

	 0.037g	 EDTA (Na2EDTA • 2H2O)

Dissolve Tris base and EDTA in 900ml deionized water. Adjust to pH 8.0 with HCl. Bring the volume to 1 liter with 
deionized water.

10.L.	Related Products

Product	 Size	 Cat.#
PowerQuant™ System	 200 reactions	 PQ5002

	 800 reactions	 PQ5008

PowerPlex® Fusion 6C System	 50 (or 100 direct-amp) reactions	 DC2705

	 200 (or 400 direct-amp) reactions	 DC2720

PowerPlex® Fusion System	 200 reactions	 DC2402

	 800 reactions	 DC2408

PowerPlex® Y23 System	 50 reactions	 DC2305

	 200 reactions	 DC2320

PowerPlex® 21 System	 200 reactions	 DC8902

	 4 × 200 reactions	 DC8942

PowerPlex® 18D System	 200 reactions	 DC1802

	 800 reactions	 DC1808
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Product	 Size	 Cat.#
PowerPlex® ESX 17 Fast System	 100 reactions	 DC1711

	 400 reactions	 DC1710

PowerPlex® ESI 17 Fast System	 100 reactions	 DC1721

	 400 reactions	 DC1720

PowerPlex® 16 HS System	 100 reactions	 DC2101

	 400 reactions	 DC2100

Water, Amplification Grade	 5 × 1,250µl	 DW0991

Not For Medical Diagnostic Use.

Sample Preparation Systems

Product	 Size	 Cat.#
DNA IQ™ System*	 100 reactions	 DC6701

	 400 reactions	 DC6700

Maxwell® 16 Instrument*	 1 each	 AS2000

Maxwell® 16 Forensic Instrument**	 1 each	 AS3060 

SwabSolution™ Kit**	 100 preps	 DC8271

5X AmpSolution™ Reagent**	 100 preps	 DM1231

DNA IQ™ Reference Sample Kit for Maxwell® 16*	 48 preps	 AS1040

DNA IQ™ Casework Pro Sample Kit for Maxwell® 16**	 48 preps	 AS1240

Slicprep™ 96 Device**	 10 pack	 V1391

*For Research Use Only. Not for use in diagnostic procedures. 
**Not For Medical Diagnostic Use.

10.M. Summary of Changes

The following changes were made to the 5/16 revision of this document:

1.	 Added modified instructions for updated Plexor® Analysis Software.

2.	 The document design was updated.
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